Skeletons in the closet
Preserved plants reveal
l pheno
ologic
cal resp
ponses
s to
climat
te cha
ange
TThis exercisee will guide you
y through the basic prrocesses of exploring
e
lon
ng‐term pheenological daata sets.
U
Using
a data set derived from herbarium specim
mens collecteed from 1906‐2009, you’ll be guided
d step‐
b
by‐step
through the proccesses of orgganizing, sum
mmarizing, visualizing,
v
a analyzing the data using
and
u
M
Microsoft
Exxcel. Discussiion question
ns and suggeestions for co
ontinued leaarning are in
ncluded for each
e
s
section.
For more background on heerbaria and how
h they’ve been used to
t study pheenology, read our
P
Primer
on heerbarium‐bassed phenolo
ogical researrch, availablee on the Education sectionn of the Califoornia
Phenology Pro
P
oject website
e (www.usanp
pn.org/cpp/education) or the
t USA Natio
onal Phenolo
ogy Network
(www.usanpn
n.org/education).
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Morre phenologyy education materials
m
and
d activities arre available online,
o
including a Primeer for herbariium‐based ph
henological reesearch; anno
otated
lecttures for universities and the public; guides to establishing and ussing
pheenology gardeens; seminar modules
m
for undergraduat
u
te/graduate students;
s
and
d standards‐alligned K‐12 leesson plans. To
T learn more and to dow
wnload
matterials, visit th
he Education section of the California Phenology
P
Pro
oject
web
bsite (www.usanpn.org/cp
pp/education) or the USA National
N
Phen
nology
Nettwork (www.u
usanpn.org/eeducation).

SSkills gained
d in Microsofft Excel by completing
c
t exercise
this
e
 Organizing data – sorting and
d filtering


marizing data – creating pivot tabless and pivot charts
c
Summ



Visuaalizing data – creating an
nd formattin
ng histogram
ms



Analyyzing data – creating scaatterplots an
nd conductin
ng
regreession analyssis

M
Materials
& knowledge needed to participate
p
in this activity


Micro
osoft Excel 2007
2
for PC – Although all
a available versions
v
of Exccel have the
e functions needed
n
to co
omplete this activity,
their navigation, and in somee cases theirr functionalitty, may
be diffferent that what is show
wn and desccribed here.



Internet access to
o download the data sett



Basicc knowledge of computeer functions

Activity introduction
Our understaanding of the global clim
O
mate system has advanceed remarkab
bly over receent decades, along
w our awaareness thatt changes in the climate system havee affected plant and animal activitiees.
with
B
Biologists
have been able to detect some
s
of the impacts of climate
c
chan
nge on livingg systems (in
ncluding
b
both
wild and cultivated populationss, species, and communities) by exp
ploring data sets from lo
ong‐term
m
monitoring
e
efforts
such as annual su
urveys of wildflower bloo
oms, land su
urface “green‐up”, animal
m
migrations,
insect emerggence, and crop
c
harvests.
In a landmarrk 2007 repo
ort, the Interrgovernmenttal Panel on Climate Chaange (IPCC)1 summarized 28,671
long‐term daata series fro
om around the world thaat document significant biological im
mpacts of cliimate
c
change.
Theyy concluded, among oth
her things, th
hat “Phenolo
ogy – the tim
ming of seaso
onal activitiees of
a
animals
and plants – is perhaps
p
the simplest
s
pro
ocess in whicch to track changes in th
he ecology of species
in response to
t climate ch
hange.” Alth
hough pheno
ological resp
ponses to clim
mate changee (and the processes
t
that
cause th
hem) vary am
mong speciees and geogrraphic region
ns, the general process is as follows::
1

Formed in 198
88 by the World Meteorologgical Organizatiion and the Un
nited Nations Environmental
E
Programme, the IPCC is
the internation
nal body of scie
entists assessin
ng the availablee scientific, tecchnical, and socio‐economic information reelevant to
u
understanding
climate change, its impacts, and options fo
or mitigating its consequencees on wild and managed systems.
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Rapiid rise of winter
te
emperatures

Earlier onset
o
of warm
spring temperature
es

Changes in phenology of
o
plants & animals

Winterss are warming nearly
twice as
a fast as summ
mers

“Growing
g season lengtth”
is changing

Observablee in long‐term
biologica
al data sets

Our understaanding of ph
O
henological responses
r
to
o climate chaange is limited by the avvailability and scope
o long‐term
of
m data sets. For
F example,, only 3.4% (or
( about 1,0
000) of the long‐term daata series that the
IPCC summarized were generated
g
in
n North Ameerica. While impressive
i
p
progress
hass been madee in the
U in recen
U.S.
nt years to esstablish a naationwide long‐term biological moniitoring progrram for acad
demic,
g
government,
, and citizen scientists (tthe USA National Phenology Networrk – www.ussanpn.org),
r
researchers
o
sourcees of long‐term historicaal data that may
m documeent
have begun examining other
p
phenologica
a
Theese research projects alsso have help
ped to impro
ove the
l changes in plants and animals.
h
historical
con
ntext in whicch phenologgical monitorring program
ms are beingg established
d. One of thee most
p
powerful
and
d extensive data
d
sourcess available iss herbarium records.
An herbarium
A
m is a researrch and educcation centeer much like a library or a museum, but
b where plants
p
c
collected
fro
om wild or cu
ultivated pop
pulations aree curated an
nd stored in a stable envvironment. After
A
p
plants
are co
ollected, pressed, and drried, they are mounted on
o museum‐‐quality paper with an
information card (including the when, where, who,
w
and otheer information pertainin
ng to the collection
location, datte, and activity). The speecimen (or “ssheet”) is then assigned an accessio
on number and
s
stored
with others
o
in a systematic manner
m
in cabinets. A sheeet and a lab
bel are detailed on the next
n
p
page.
TThere are ovver 600 herbaria in the U.S.
U containing over 260 million speccimens. Mosst herbaria are
a
located at un
niversities an
nd botanic gardens
g
but they
t
may alsso be found at National Parks and in
n private
c
collections.
In the absence of long‐teerm monitorring data obtained at a single
s
locatio
on for manyy years
u
using
standardized meth
hods for observing and recording
r
ph
henological events
e
or phases, herbarria are
p
perhaps
our best reposittories of histtorical inform
mation that can be used
d to study bio
ological resp
ponses
t environmental change
to
es, includingg climate chaange.
FFor more infformation on
n herbaria an
nd how theyy’ve been used to study phenology and
a climate change,
r
read
our Prim
mer on herba
arium‐based
d phenologiccal research,, available on
n the Educattion section of the
California Pheenology Proje
C
ect website (w
www.usanpn.org/cpp/educcation) or thee USA Nationaal Phenology Network
(www.usanpn
n.org/education).

A photos in this
All
t activity guide
g
were taken by Brian Haggerty
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A

B

C

A) Exam
mple of a pre
eserved and cataloged California
C
po
oppy herbarium specimeen. On this sheet,
the entire
e
plant is available for
f study, in
ncluding its root
r
and all reproductive structuress. The
accesssion numbe
er is stampeed in the upp
per‐right corrner of the herbarium
h
sheet, and a label
including information about the collectiion appears in the loweer‐right corner. A hand‐m
made
envelope (visible
e at the botttom of the sheet)
s
is ofteen glued to a sheet in order to storee any
fragm
ments or see
eds that beco
ome separatted from thee plant.
B) Recent hillside population off California poppy
p
in thee southern Siierra Nevadaa Mountainss.
C) Hand
dwritten collection labeel from a specimen co
ollected 1906. Comparee the amount of
information provvided on thiss label comp
pared to the label below
w.

The format of herbarium sheett labels may differ amon
ng herbaria, collectors,
c
and time
periodss. Most labells will include much of th
he information shown here,
h
with so
ome modern
n
labels having
h
GPS coordinates
c
f the collection site ass well (as sho
for
own here).
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Background on the data set –The data set for this activity comes from a research project underway at
the University of California, Santa Barbara designed to assess the effects of climate change on plant
phenology in California. The focus of the data set used in this exercise is the widely‐distributed and
frequently‐collected California poppy (Eschscholzia californica). Several herbaria were visited (and
loans were requested from others through the Consortium of California Herbaria) to examine
specimens and to answer the following research question: “Has the flowering time of California poppy
changed in California in recent decades?” Based on the reasoning above, we predicted that, in
response to a warming climate, we’d find that California Poppies are flowering earlier now than at the
beginning of the 20th century. You will be able to answer this question and test this prediction by
completing this activity while learning (or reinforcing) basic skills in data processing and analysis.
Data collection – We browsed the herbarium collections to find California poppy plants that were
collected shortly after producing their first flowers – the preserved plant had only one or two flowers
open, many flower buds, and no wilted flowers or developing fruits. We also examined some plants
that were collected at peak flowering (when stems bear a large proportion of flowers relative to flower
buds and developing fruits). Only specimens that did not have any missing parts were included in the
data set – the entire plant had to be visible for examination. This criterion assured that our assessment
of an individual plant’s flowering phase was correct; for example, the flowering status of “missing”
branches may have altered our conclusion as to whether a plant was producing its very first flower).
We recorded the collection information from each of the specimens into an Excel spreadsheet with the
following column headers:


herbarium



accession number



collector name(s)



date of collection (month,
day, year)



location of collection (county, and
elevation, latitude, and longitude if
available)

In some cases, more than one individual plant was mounted on one sheet. In these instances, the collector
simply collected several plants from the same location on the same day and mounted them on the same
sheet. In the data set, therefore, it will appear as though some rows are repeated… in fact, this is due to
the fact that several individuals per sheet were included in the study.
Data processing – After visiting each herbarium, we converted the collection date to a “day of year” value.
Thus, specimens collected January 1 would be assigned a value of 1, and specimens collected December 31
would be assigned a value of 365 (leap years are a critical part of this conversion! We identified the leap
years in the data set and adjusted the day of year values accordingly). We also converted all elevation
values to meters. In this activity you will perform several other data‐processing steps for organizing and
exploring the data.
Please note that other types of information were recorded for this research project, and other types of
data‐processing steps (not covered in this activity) have been taken to analyze the data. Since this is an
ongoing research project, however, only a subset of the entire data set is currently included for this
activity. Once the research project is complete, the entire data set will be made public through the USA
National Phenology Network and this activity guide will be updated.
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Data conventions & definitions –
It is general practice among researchers to write column headers with no spaces between words. In this activity,
you’ll see “DayOfYear” instead of “Day Of Year”, and you’ll write “Year_bins” instead of “Year bins”. This is

a standard convention because spaces between words can create problems when exporting the data set
into some statistical analysis programs (which you won’t do in this activity).
We also have included two columns to identify the herbarium from which each specimen was sampled.
One column provides the full name of the herbarium, and the other column reports an abbreviation of the
herbarium name. The abbreviations are routinely used by experienced botanists as a shorthand, but
because this data set may be shared among students and instructors who are unfamiliar with them, it’s
important to include the full name as well. While many researchers use abbreviations to describe
attributes of their data in spreadsheets, this can be a risky practice because the essential information can
be lost as time passes and memories fade. Moreover, when data are shared with the public, it’s helpful to
minimize the amount of explanatory information that must be provided, and reducing the use of
abbreviations within data sets can help to achieve this.

Outline of the procedure you’ll follow to explore historical flowering phenology of California poppy
Page
7

Process
Step 1 Download data
set

Procedures
Visit the USA National
Phenology Network
website

Goal / Outcome
Open the file
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Step 2

Organize data

Sort & Filter

Clean up the data set for
next steps

9

Step 3

Summarize data

PivotTable & PivotChart

Determine the number of
herbaria, the number of
specimens per herbarium,
and the number of
collections per county in
California

11

Step 4

Visualize data &
format for
presenting

Histogram

Create a frequency
distribution of collection
year, day of year, and
elevation

19

Step 5

Examine data for Scatter plot
long‐term trends Regression analysis

Create a scatter plot and
add a trendline
Conduct a regression
analysis
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S
STEP
1: DOWNL
D
LOAD TH
HE DATA
A
Visit the Edu
V
ucation sectio
on of the Caalifornia Phenology Projeect (www.ussanpn.org/cp
pp/educatio
on) or of the
U Nationaal Phenologyy Network (w
USA
www.usanpn
n.org/educattion). Browse the availab
ble files for a Microsoft
E
Excel
file enttitled “Herbaarium‐based
d phenology data activityy”. Then dow
wnload the data
d
set, savve it to your
c
computer,
an
nd open the
e file. It should look like this
t once op
pened:

S
STEP
2: SORT
S
AN
ND FILT
TER THE DATA
Now you’re ready
N
r
to cleaan up the daata by sortin
ng and filtering. Sorting data
d
simply rearranges
r
r
rows
on the
s
spreadsheet
; filtering daata actually hides
h
unwan
nted rows. Both processees are usefu
ul to learn, paarticularly
f the purpo
for
oses of prep
paring a dataa set for analysis.
1 Sort the dataset. Firsst highlight the
1.
t entire daata set by cliicking on thee upper‐left corner of th
he
heet (1). Nexxt, select [Daata > Sort]. The
T Sort wind
dow will app
pear (see neext page for an
a image) –
spreadsh
make surre the “My data
d
has heaaders” box iss checked, th
hen sort by Year
Y
(on valu
ues, order sm
mallest to
largest). Then “Add Level”,
L
and then
t
sort by DayOfYear (on
( values, order
o
smalleest to largestt). Click OK.
e data set will become reearranged.
All of thee rows in the

2

3

1

Sort window shown
n on next pagee
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Your dataa set should appear as below
b
– checck that Accession 149294 from RSA‐‐POM is in ceell C2, and
that therre are 149 ro
ows of data (therefore,
(
s
sample
size N=148
N
because of the header row). It is
imperative to remem
mber to sortt the entire data
d
set eve
ery time you
u sort – if yo
ou sort just a few
ntly of the entire
e
data set
s then you
u’ll disassociaate the dataa! For examp
ple, if you
columns independen
ear column independen
i
t of the spreeadsheet, then Accession 149294 in row 2 will
sort just the DayOfYe
be re‐asssigned to a DayOfYear
D
off 64 (go ahead and try itt – Excel sho
ould try to stop you from
m doing this,
but go ah
head to see what happens. Afterward, just hit CTRL+Z
C
once to step backkward, makiing sure
your dataa set matche
es the imagee below befo
ore continuin
ng).

2 Filter outt unwanted data. Now that
2.
t
your daata set is sortted by Year and DayOfYYear, filter ou
ut unwanted
d
rows of data.
d
There are
a only 9 sp
pecimens rep
presenting the
t Peak Flow
wering phen
nophase (not enough
power fo
or a robust sttudy), and th
here is one specimen
s
fro
om Baja (outtside the geo
ographic reggion of
interest for
f this study). Instead of
o searching for these ro
ows individuaally and deleeting them, filtering
f
provides an automatted solution (see next paage for imagge):
a. With any cell highlighted, sellect [Data > Filter]. A new
w symbol will appear in the corner of
o each
header cell. Clickk on the symbol for the County
C
colum
mn, un‐checck the box fo
or Baja, then click OK.
b. Repeat these steps for the Ph
henophase column
c
(un‐check Peak Flowering).
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1

2

3

4

Importan
nt note #1: The
T filtered data don’t actually
a
get deleted – th
hey only beccome hidden until you
clear the
e filter. Scan down to thee bottom of the data sett – there still should be 149 rows, ho
owever you
should bee missing se
everal rows throughout
t
t data set. The data arre hidden un
the
ntil you selecct [Data >
Filter] aggain.
Can you bring
b
back the filtered data?
d
Yes. Just release th
he filter by clicking
c
on [D
Data > Filter]] again.
How do you
y know wh
hether a colu
umn has beeen filtered? The
T symbol in the headeer row changges, and thee
row num
mbers below the header row are colo
ored. Noticee how the symbol for thee County and
d
Phenoph
hase columns appears different than
n in the otheer columns. Click
C
on the symbol and it will
remind you
y how the data have been
b
filtered
d. You also caan adjust thee filter again
n.

Importan
nt note #2: The
T data visualizations and analyse
es that you will
w conduct in the next steps of
this exerrcise do not necessarily recognize th
he data filte
er that you’vve just applie
ed. The easiest way
around this problem is to copy and paste thee entire dataa set to a new worksheeet. To do thiss:
1. Highlight
H
and
d copy the daata set eitheer by:
a. Hold a left‐click while
w
highligh
hting the datta set from cell
c A1 to cell M149, theen either usee
[Ctrl+C] or right‐click and seleect copy; or
ner of the sp
preadsheet (circled below
w) and selecct copy.
b. Right‐‐click the upper‐left corn

9

2. N
Next, click on
n the ‘Insert worksheet’ symbol thatt is located at
a the bottom
m of the win
ndow, next
to
o the title off your curren
nt worksheet ‘CA poppy herbarium data’.
d

3. A new worksh
heet should appear titleed ‘Sheet 1’. Right‐click on
o cell A1 (th
he upper‐lefft corner of
th
he spreadsheet) and seleect Paste, orr select cell A1
A and use [Ctrl+V].
[
You
ur filtered daata set is
now pasted, excluding
e
th
he rows that you filtered
d on the prevvious spread
dsheet. You can
c check
th
his by scanning down to view the to
otal number of rows (it should be 139 rows inclu
uding the
headers). Right‐click the title
t
of ‘Sheeet 1’ and ren
name this wo
orksheet ‘Filltered data for
f analyses’’
(ssee below).

4. N
Notice how th
he column width
w
is too narrow
n
for some
s
column
ns? There is an easy fix for
f this.
H
Highlight
the entire data set again (leeft‐click the upper‐left co
orner of thee spreadsheeet), and then
n
double‐click the
t dividing line betweeen any two columns.
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1

2

With you
ur column width adjusted, you should now be reeady to summarize, visualize, and an
nalyze the
data set.

S
STEP
3: SUMMAR
S
RIZE TH
HE DATA
A SET
Basic “summ
B
mary informaation” aboutt a data set iss a standard
d part of any research prroject and prresentation.
H many herbaria
How
h
are represented
d in this dataa set? How many
m
specim
mens per herrbarium were included?
W answerr these quesstions not byy counting ro
We’ll
ow‐by‐row, but
b by usingg automated tools called
d PivotTabless
a PivotChaarts.
and
C
CREATE
A PIVOTTABLE AND
A
A PIVO
OTCHART
1 With anyy cell highligh
1.
hted, select [Insert > PivvotTable > PiivotChart]. The
T “Create PivotTable with
w
PivotChart” dialog bo
ox will open. By default, the entire data
d
set will be selected (don’t worrry about the
i fine). Makke sure that “New
“
Workssheet” is selected, and
$ symboll in the range of data selected, this is
click OK.

11

2. A new worksheet will appear – itt looks a bit complicated
d, but don’t be intimidatted! Providee a new
name forr the worksh
heet, such ass “PivotCharts”. Arrangee the pop‐up
p windows so
o you can seee each of
them (seee below for example), and
a then focus on the “P
PivotTable Field List” win
ndow. Be surre that the
box in the bottom‐le
eft corner called “Defer layout updatte” is un‐cheecked.
Check the box at “He
erbarium_Co
ode”, and then grab the Herbarium__Code namee and drag it to the “Axiss
Fields (Caategories)” and
a the “Vallues” window
ws. The table should auttomatically fill
f in, and so
o should thee
chart. Th
hese are your PivotTablee and PivotCh
hart. Notice that the Graand Total is 138, indicating that
your filteered data have, in fact, been
b
left beh
hind in your new ‘Filtereed data for analyses’
a
worksheet.
Play with
h the other categories
c
off data as follows in order to explore the PivotCh
hart function
n.

Select an
nd drag Mon
nth into the “Axis Fields”” window wiith Herbarium. Determine the mostt frequentlyy‐
represen
nted month of collection
ns in each he
erbarium.
With Mo
onth and He
erbarium in the “Axis Fields”
F
window, change their positiions so Mon
nth is abovee
Herbarium. How doe
es this changge the table
e and chart?
What happens when
n you move herbarium to
t the “Lege
end Fields (SSeries)” wind
dow?
Now un‐check Herbaarium and Month,
M
and in
nstead check County. Which
W
countyy is represen
nted most in
n
the data set? Where
e is that coun
nty located??
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You should have noticed that “Axis Fields” and “Legend Field” are two different ways to view the same
information. There is no right or wrong way to display the information, but the general rule is to keep
tables and charts as simple and clean as possible. For our data set, Axis Fields seems to be the better
option. In the next section of this activity you’ll have the opportunity to change the formatting on charts to
improve not just their appearance but also the quality of the information conveyed. Leave your pivot chart
set to summarize Herbarium and Month for now, and continue to the Step 4 to visualize the data in a
histogram.

STEP 4: VISUALIZE THE DATA
One of the first steps all researchers take in analyzing data sets is visualizing the distribution of the data. It
is important to understand the structure of the data before exploring trends in the data and interpreting
results. Many statistical tests require that the data show a “bell‐shaped” or “normal” distribution, with
most data points clustered near the average (or mean) value of the distribution and the rest of the data
points representing values that are more distant from the mean (including values that are both higher and
lower than the mean). The values that deviate greatly from the mean are relatively infrequent, and appear
as the “tails” of the bell‐shaped distribution. For many statistical tests (e.g., regressions, t‐tests, and the
analysis of variance), if the data aren’t normally distributed, then the criteria for accepting or rejecting the
hypothesis tested by the procedure will not be accurate. To visualize data you’ll make a histogram
containing a frequency distribution, for several variables in the data set. Return to the data set and
continue using filtered data from Step 1.

CREATE A HISTOGRAM FOR THE NUMBER OF SPECIMENS PER YEAR
1. Determine the smallest and largest values for the Year column – these will become the lower and
upper limits on the x‐axis of your histogram. With the data sorted and filtered, scan through the Year
column and identify the earliest and latest years in the data set. Alternatively, you could click on the
filter pull‐down menu for the Year column and scan that. Remember these two years (or write them
down) before proceeding to the next step.
Tip: When scanning down the Year column to find the latest year, you’ll notice that the headers in row 1
disappear. If you want to keep the headers in view at all times, click [View > Freeze panes > Freeze top row].

2. Create bins for the term Year. Bins are categories for the data – they will be the x‐axis intervals in the
histogram. For our histogram, each year will be a bin.
Establish a new column on the spreadsheet. Right‐click the top of a column (we right‐clicked column H
containing DayOfYear). On the pop‐up window, select Insert. A new blank column will appear in
column H, and the Elevation column (and everything else to the right) will shift to the right to make
room.
Type in the column header “Year_bins”, then adjust the column width to make room for the full
header. In row 2, type in the earliest year in the data set (1906). Actually, for reasons you’ll see later
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when thee histogram is created, go
g ahead and type in a nice
n round number preceding your earliest
e
data
point… tyype in 1900. In row 3, tyype in the neext year (190
01), and continue filling in the Year__bins column
n
until you reach the laatest year in
n the data seet (2009). On
nce again, go
o ahead and continue to
o the nice
round nu
umber of 201
10. To autom
mate this fill‐in process, just type in the first two
o years in the
appropriate cells, higghlight thosee two cells, then
t
grab the bottom‐rigght corner of
o the highligghted cells
and dragg the highligh
hted area do
own until thee automatic counter reaaches 2010. There
T
will bee blank cellss
below the 2010 cell – that’s correct.

What hap
ppens if you highlight
h
just one
o cell and drag
d
it down??
What hap
ppens if you highlight
h
both
h cells but theen grab and drag
d
a differen
nt corner, or the side of th
he highlighted
d
area?

o the highligh
hted cells. All the cells in the column sh
hould be filled
d
Try double‐clicking on the bottom‐rright corner of
w far down do
oes the automatic fill‐in work?
w
Did it stop at 2010
0 where you wanted? If it
in automaatically. How
continued
d farther than
n 2010, when did it stop an
nd why?
Now go back
b
a step – clear the column, type in
n 1900 and 1901
1
again. This time, typee in somethin
ng a few cells
down – an
nything. Then
n perform thee same double‐click autom
matic fill‐in agaain… what haappened?
Always bee cautious wiith the autom
matic fill‐in to
ools, and checck their accurracy!
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3. Create th
he histogram
m. With any cell on the spreadsheet
s
t selected, op
pen the Dataa Analysis to
ool [Data >
Data Anaalysis]. Select Histogram and click OK
K.

1

2

3
n’t fret! If you haven’t ussed it beforee on your com
mputer, you
u’ll
If you can’t find the Data Analyssis tool, don
probablyy have to acttivate it. You
u only have to do it oncee; it takes jusst a momentt following th
hese steps:
Click the Microsoft Office
O
symbo
ol at the upp
per‐left corner of the window, and then
t
click Excel Options.. A
dow should pop up. Find
d Add‐Ins on
n the left collumn, click on
o it, and theen click on Analysis
A
new wind
ToolPak (you can ign
nore the Too
olpak with th
he VBA optio
on). Click OK
K. If you havee trouble goiing through
this process, or if you
u want to leaarn more ab
bout Add‐Inss, consult thee Microsoft Support
S
web
bsite (search
h
for Analyysis ToolPak or Add‐Ins).


With the Histogrram dialog box
b open, se
elect the Input Range. Click on the In
nput Range symbol
(circleed in red below); then highlight
h
all of
o the valuess in the Yearrs column off the data set; and then
click again on the
e symbol in the
t dialog bo
ox. The assiggned input raange should
d be from cell H2 to cell
H139
9 (the $ symb
bols will app
pear automatically – thatt’s correct).



Selecct the Bin Raange
Repeat the same
e process forr the Bin
Range by clickingg the “Bin Raange”
symb
bol in the diaalog box; seleecting the
valuees in the Year_bins colum
mn of the
data set (I2 to I11
12), and then clicking
the syymbol again
n to return to
o the
Histo
ogram windo
ow.
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Selecct the Outpu
ut Options
Selecct “New Worrksheet Ply:”” and type in
n a brief titlee (for example, “Hgram by
b year”). Bee sure to
select “Chart Outtput”. Click OK.
O



w the histogrram
View
A new
w worksheett will appearr with Bin an
nd Frequency columns, and
a a histogram. Voilà! The
T
histogram may be pretty smaall, so drag a corner to in
ncrease the size.

n your keybo
oard while drragging the corner, you’’ll keep the same
s
Tip: Iff you hold down Shift on
propo
ortions as yo
ou increase size.
s
This is generally
g
tru
ue in all Micrrosoft applications and in
n many
otherr graphic dessign program
ms.
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FORMAT THE HISTOGRAM FOR INTERPRETATION, SHARING, AND PRESENTING
The histogram you produced is displayed in the default format. Though effective in visualizing the data, we
should make a few brief formatting changes to make it appear cleaner while enhancing the information
that can be extracted from the chart.
Chart Title

Chart area

Plot area

Legend

Y‐axis

X‐axis

Chart border

The area of the histogram with the vertical bars (bounded by a gray box) is called the “plot area”, and it
essentially floats over the “chart area” (which includes the axes and their titles, the chart title, legend,
background, and border). Pause your cursor over these areas to become familiar with their boundaries.
Notice that you can left‐click or right‐click on each component of the histogram and format its appearance.
Format the histogram as follows:


Titles – Left‐click the chart title and change it to “Frequency distribution of California poppy specimens
in herbarium‐based phenology activity”. Change the title font size to 16. Next change the x‐axis title to
“Year of specimen collection”. Change the axis title font size to 14.



Legend – Left‐click and delete the legend (while critical for other types of graphs, it is not necessary for
this histogram).



Data series – Right click any of the vertical data bars and select “Format data series…”. From the left
column select “Fill”, then select “Solid fill”, then choose a dark bold color (we’ve selected a dark gray).
Also format the “Border color” in the same way (we’ve selected black).



Axes – Change several components of each axis by right‐clicking on the axis and selecting “format axis…”.
Do the following:
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F the x‐axis, under “axxis options”:
For


Change the “Inte
erval betweeen tick markss” to 5 yearss



Change the “Inte
erval betweeen labels” to 10 years



e other form
matting optio
ons, but don
n’t
Brieflly look at the
get lo
ost in the details. Remem
mber – keep
p it simple an
nd
clean
n.

F the y‐axis, under “axxis options”:
For


nd type in 20
0
Change the “Maxximum valuee” to fixed an



f
and typ
pe in 5
Change the “Major unit” to fixed



e other form
matting optio
ons, but don
n’t get
Brieflly look at the
lost in
n the detailss. Remember – keep it simple and cllean.

FFinally, making sure the chart area iss highlighted
d (that is, clicck on the
c
chart
with th
he cursor ratther than on
n a cell in thee spreadsheeet), select
[
[Insert
> Text Box]. Left‐cclick and draag the cursor to create a small text
b anywherre on the chart area. Typ
box
pe in “N = 13
38” (this is th
he sample
s of the sttudy after filtering). Dragg the box to the side of the
size
t plot areaa.

Y
Your
chart sh
hould be forrmatted as follows:
f
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The histogram now appears cleaner and is easier to read because of simplifying changes such as longer
axis intervals (but not too long), and fewer tick bars between intervals. In addition, the new titles and
sample size help to describe the context for the data better than the default appearance.
The distribution of the data indicates that the frequency (simply, the number) of specimens in the
herbarium phenology data set varies by year and by decade. There is, more or less, good representation of
specimens over the century, but some decades (1960’s, 2000’s) are better represented than others
(1910’s, 1940’s, 1980’s). Do you think this might affect any trends we find in the next step? How?

Now that you’ve completed the process of creating a histogram for one aspect of the herbarium
phenology data set, you should be capable of creating other histograms from the same data set.
Following the same process as above, create a histogram for the DayOfYear variable. For this data
visualization, you will ignore Year and just examine the seasonal distribution of California poppy
collections. When is the most frequent time of year for botanists to collect California poppy plants in the
first flower phenophase?
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Now create a histogram for the Elevation variable. Sort the data set by Elevation, determine the lowest
and highest elevation values, create an “Elevation_bins” column, and then create and format a histogram.
Keep in mind that not all specimens in the data set have elevation values, so the sample size decreased to
N=99 and the time span changed to 1912 – 2009.

Challenge: Interpret the distributions

How could the following factors affect the frequency distributions of California poppy specimens?
 The biology of California poppy
 Collectors
 Data collection method allowing for several individuals per sheet to be included
 Herbaria
 Historical socioeconomic events
How might the frequency distributions affect our interpretation of later results?

STEP 5: EXAMINE THE DATA FOR LONG-TERM TRENDS
Once the data set has been visualized and you have an understanding of the distribution of the data
points, begin exploring the data for long‐term changes in the flowering phenology of California poppy. Our
filtered data set includes only plants that were collected in the same phenophase (first open flower), and
long‐term changes would manifest in temporal changes in the collection times. You will create a scatter
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plot to visually inspect th
p
he long‐term
m trend, and then condu
uct a regression analysis to assess th
he
r
relationship
between the DayOfYearr and Year vaariables.

C
CREATE
A SCATTERP
S
LOT
Highlight thee Year colum
H
mn (left‐click column F). Then,
T
while holding dow
wn the Ctrl key, highlightt the
D
DayOfYear
co
olumn. Both
h columns sh
hould be highlighted. Neext, select [In
nsert>Scatteer> Scatter with
w only
m
markers].

Notice that the
N
t Year colu
umn (not vissible in this image) lies to
o the left of the DayOfYeear column. This means
t
that
in the reesulting grap
ph, Year will be on the x‐‐axis and DaayOfYear will be on the y‐axis.
y
The sttandard
c
convention
in Excel is that the left highlighted co
olumn will be
b the indepeendent variaable (x‐axis) and the
r
right
highligh
hted column
n will be the dependent variable (y‐aaxis).
1 View & format
1.
f
the scatter
s
plot. The graph should
s
appeaar on the sam
me worksheeet and look like this:
Chart Title
Gridlines

Legend

Y‐axis

X‐axis
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Formatting a scatter plot for clarrity and simp
plification is similar to fo
ormatting a histogram
h
– a few
changes are all that’ss needed to improve thee clarity of th
he graph. Fo
ollow the sam
me steps you
u took to
format th
he histogram
m. Also, deleete the gridlines by right‐clicking and
d selecting delete.
d
To ad
dd axis titles,,
select [Ch
hart Tools > Layout > Axxis Titles].

2 Add a tre
2.
endline to th
he scatter plot. Right‐cliick on any off the
data poin
nts and selecct “Add tren
ndline…”.In the left colum
mn of
the Form
mat Trendline
e window, seelect “Trend
dline Optionss” and
then makke sure that the followin
ng three com
mponents are
selected::
a. Trend/Regresssion Type – Linear
b. “D
Display equaation on chaart”
c. “D
Display R‐square value on
o chart”

F
Finally,
yourr scatter plott should app
pear similar to this:
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A trendline also is commonly called a “line of best fit” because it is a line drawn through a cloud of data
points that minimizes the sum of all of the distances (or “deviations”) between each data point and the
trendline. The trendline is described by the general equation y = mx + b. In our data set, we already know x
(Year) and y (DayOfYear), so we’re solving for m (the slope of the line). The value b is simply the y‐
intercept.
There are a few mathematical methods by which to calculate the distances from each data point to the
trendline – the most common method minimizes the vertical distance between each data point and the
trendline (called ordinary least squares). The R2 value (spoken “R square”) represents the amount of
scatter around this trendline – the more scattered the data, the closer to 0 the R2 value becomes; the
more linear the relationship (and the lower the scatter above and below the line of best fit) between the
X‐ and Y‐variables, the closer to 1 the R2value becomes. In other words, R2represents the amount of
variation in the Y‐variable (DayOfYear) that can be explained by variation in the X‐variable (Year).

Challenge: Interpret the California poppy herbarium collection record trend
Include the trendline slope and the R2 value in your answer. The most complete interpretations also will
refer to the histograms previously created, and any other aspects of the data set that seem appropriate to
discuss (and, potentially, to visualize). How could you incorporate factors from the previous challenge into
your analysis and interpretation?

Example interpretation of the data – The data indicate a long‐term trend toward earlier collection dates of
California poppy, suggesting earlier flowering in recent years across California. Specifically, the slope of the
trendline (‐0.391) indicates that for every year (x) that passes, the California poppy plants included in this
study and in the “first open flower” phenophase are, on average, collected about 0.4 days earlier, equivalent
to about 4 days earlier per decade. This rate of phenological change is consistent with other reported values
for observed wildflower phenological changes. In addition, the R2 value indicates that about 16% of the
variation in collection date can be explained by the year in which the plant was collected. Though not very
high (recall R2 ranges from 0‐1), this R2 value falls within a range commonly observed in ecological studies.
Note that, in this analysis, we did not control for possible effects of elevation or latitude on the phenological
behavior of California poppy. We might expect, for example, that – all else being equal – plants collected
from lower latitudes and elevations in California would flower earlier than those collected at higher latitudes
and elevations. If this is the case, and if (by chance) more recently sampled plants happened to be collected
from lower elevations or lower latitudes than plants sampled in the past, then this nonrandom distribution
of elevations and latitudes across time could contribute to the temporal trend observed. How might this be
controlled for in your data set?
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C
CONDUCT
A REGRESSSION ANA
ALYSIS
TThe ultimatee goal of regrression analysis is to dettermine our confidence level in stating that the slope of thee
t
trendline
is not
n zero (sou
unds excitingg, doesn’t it?!). In other words, we need
n
to takee the importtant step of
d
determining
how confide
ent we are that
t
flowerin
ng phenology of Californ
nia poppy is really changging.
1 With anyy cell selecte
1.
ed, select [D
Data > Data Analysis]
A
and
then sele
ect “Regresssion” in the pop‐up wind
dow.
2 Select input ranges and
2.
a output options.
o
Select the
appropriate Y (DayOffYear) and X (Year) valuees, and provvide
a title forr the New Worksheet
W
Ply (regressions are
common
nly referred to
t as “Y verssus X”, so wee used
“DayOfYeear vs Year”).

3 View and
3.
d interpret the
t regressio
on Summaryy Output.
R2 value is slightlyy lower than
the
calculation
previous
becau
use regressio
on is more
conseervative (and generally
moree accurate).

The
“F‐test”
resu
ult
indicates that there iss a
0.0000023
3 chance th
hat
the regresssion line really
does havee a zero slop
pe.
In other words,
w
we aare
precisely 99.999998
8%
confident that this daata
set indicaates Californ
nia
poppy
plants
aare
flowering earlier.

The slope of the regresssion line is reeported as th
he coefficient of the x variaable.

Challenge
C
U
Using
the intternet and/o
or any availaable statisticaal texts, learrn more abo
out the ANOV
VA (analysis of variance))
a F‐test th
and
hat were a paart of the regression anaalysis. Provid
de an interpretation of the
t regressio
on results
including a description
d
of
o the reportted standard
d error (locatted below th
he ‘R Squaree’ value in the
R
Regression
S
Statistics
table) and loweer/upper 95%
% confidence intervals (located near the bottom
m‐right
c
corner
of thee table).
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